
USER GUIDE TO THE ESRI
WORKPLACE UPDATE EXTENSION



2

Table of Contents

Chapter 1  Welcome to the Workplace Update Extension ...................... 5

Reviewing Employer Data with the Workplace Update Extension ............................ 5
Procedure for Updating Employer Files with the Workplace Update Extension ........ 5
Recommended Hardware and Settings...................................................................... 6
Loading the TIGER/Line Shapefiles and Employer Data Sets................................... 7
Files on the Distribution CD–ROM .......................................................................... 7
Copying the County-Specific Files to Your Hard Disk.............................................. 8
Source of the Employer Data Sets ............................................................................ 8
Technical Support .................................................................................................... 9

Chapter 2  Basics of ArcView GIS and the Work-UP Extension ............ 10

Workplace Update Interface ..................................................................................... 10
The Graphical User Interface .............................................................................. 10
The Status Bar .................................................................................................... 11

Workplace Update View........................................................................................... 11
Themes............................................................................................................... 12
Table of Contents ............................................................................................... 12
Map Display ....................................................................................................... 12

Common Theme Operations ..................................................................................... 12
Turning Themes On and Off ............................................................................... 12
Making a Theme Active...................................................................................... 12
Changing the Display Order ............................................................................... 13

Adjusting the Map Display ....................................................................................... 13
Zooming In......................................................................................................... 13
Zooming Out ...................................................................................................... 14
Pan ..................................................................................................................... 14
Previous Extent .................................................................................................. 15
Display Entire County In Map Display ............................................................... 15

Importing Other ArcView Shapefiles for Reference.................................................. 15
Importing Shapefiles........................................................................................... 15
Changing Theme Symbology.............................................................................. 16
Remove Themes ................................................................................................. 16



3

Showing Theme Feature Attributes........................................................................... 16

Labeling Theme Features in the Map Display ........................................................... 17
Labeling Streets.................................................................................................. 17
Labeling Individual Features............................................................................... 18
Deleting Labels................................................................................................... 18
Moving Labels.................................................................................................... 18
Resize a Label .................................................................................................... 18

Printing the Workplace Update View........................................................................ 19

Chapter 3  Starting the Workplace Update Extension ............................ 20

Option 1:  Loading the Workplace Update Extension ............................................... 20
Option 2:  Opening a Saved Workplace Update Review ........................................... 21
Entering the Workplace Update Extension................................................................ 22
Selecting a County for Review ................................................................................. 23
Data Input Options ................................................................................................... 23
Adding Street Data (if not already loaded in Workplace Update View)..................... 25
Importing Employer Data Sets (if not already loaded in the Workplace Update View) 26

Chapter 4  Selecting Records to Review ................................................... 28

Workplace Update Extension Interface..................................................................... 29
Selecting Employer Data Set Records to Review...................................................... 30
Pre-Select Operations ............................................................................................... 31

Spatial Select...................................................................................................... 31
Query Builder..................................................................................................... 31

Define Selection Criteria .......................................................................................... 33
List Selected Records ............................................................................................... 36

Chapter 5  Reviewing Employer Data Sets............................................... 38

Examining the Employer Data Sets .......................................................................... 38
Begin the Review of Employer Data Sets ................................................................. 40
Review Geocoded Employer Data ............................................................................ 41
Review Ungeocoded Employer Data ........................................................................ 48
Adding Employers.................................................................................................... 48
Reviewing Data for Another County......................................................................... 59



4

Chapter 6  Exporting Employer Data Sets ............................................... 61

Sending Completing Files to the Census Bureau....................................................... 62
Returning Licensed Employer Files to the Census Bureau ........................................ 62

Appendix A  Graphical User Interface (GUI) .......................................... 64
Appendix B  Employer Data Set Record Description .............................. 67



5

Chapter 1

Welcome to the Workplace Update Extension

The Workplace Update (Work-UP) extension has been developed by Environmental
Systems Research Institute, Inc. (ESRI), for the U.S. Census Bureau in support of Census
2000 place-of-work coding.  The Workplace Update extension is being distributed to
Metropolitan Planning Organizations (MPOs) so they can use local knowledge to verify,
correct, and add entries for employers in their area to ensure more accurate and complete
workplace data in the Census Transportation Planning Package (CTPP) 2000.

Reviewing Employer Data with the Workplace Update Extension

The Workplace Update extension is a tool for MPOs to use in reviewing the commercial
business database that has been licensed by the Census Bureau.  The extension was built
using, and runs in, ArcView® GIS 3.1, but will also work with version 3.2.  An ArcView
extension is one file that, when loaded, extracts all programs, tools, and dialog forms for
additional functionality not native to core ArcView GIS.

The Workplace Update extension enables users to do the following:

• Validate employers successfully geocoded by the Census Bureau by visually
verifying each location.

• Geocode any employers the Census Bureau could not, by either typing in a more
complete (or different) address or by clicking on the correct location on the map.

• Add any missing employers by typing in their name and address.

• Delete any employers that are no longer valid.

• Change employer information and/or location on an as-needed basis.

Procedure for Updating Employer Files with the Workplace Update
Extension

The process by which MPOs will check over and correct the employer lists is

• MPOs will receive a CD-ROM containing the appropriate TIGER/Line 98 ArcView
shapefiles, the Workplace Update extension, and Employer Data files for each
county.  There will be two employer files, one for records geocoded by the Census
Bureau and another for records that were not able to be geocoded.
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• MPOs will spend a few months going through the Employer Data files, validating the
correct employer addresses, correcting problematic employers, and adding the
missing employers and their addresses.

• Once the MPOs are finished checking the Employer Data files using the Workplace
Update extension, the exported output files will be sent back to the Census Bureau,
Journey-to-Work and Migration Branch.  The output will consist of ASCII versions
of the revised employer files, with "flags" on validated, changed, or deleted records.

• In accordance with the provisions of the license agreement with the vendor who owns
the business database, at the conclusion of the project the original CDs must be
returned to the Census Bureau and the employer files must be deleted from the MPOs
computers.  Agencies interested in licensing the employer files for their own use
should call the Journey-to-Work and Migration Branch of the Census Bureau for
information on how to contact the vendor.  See Technical Support at the end of this
chapter for the telephone number and names of whom to contact.

• After basic completeness and edit checks have been performed, the Census Bureau
Geography Division will integrate the files from the MPOs into the master Workplace
File for use in Census 2000 place-of-work coding.

Recommended Hardware and Settings

The following is recommended hardware for the Workplace Update extension and
ArcView GIS.

Hardware

• Pentium PC (200 MHz or better).

• Microsoft Windows 95, Windows 98, or Windows NT 4.0 operating system.

• 64 MB physical memory (RAM).

• The amount of hard disk space required will depend on the size of the TIGER/Line 98
ArcView shapefiles and the employer files for your area.  The Work-UP installation
utility will tell you how much space is needed for the extension, user guide, and
associated files but cannot estimate the size of the TIGER files and employer files
because they vary from county to county.

• 15" VGA color monitor (256 colors or more) and 8 MB video memory.
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Settings

In order to display the dialog boxes properly follow the settings below.

• Font Size should be set to Small Font.

• Desktop Area should be set to 1024x768 pixels.

To check settings, go to the Windows Start menu → Settings → Control Panel →
Display icon → Settings tab.

Loading the TIGER/Line Shapefiles and Employer Data Sets

The installation program on the distribution CD only installs the Workplace Update
extension, the user guide, and other program-related files.  It does not install any of the
county-specific TIGER/Line 98 ArcView shapefiles or Employer Data sets.  You must
choose the counties you are going to work on and copy the county folders from the CD to
a specific directory on your computer's hard disk drive as noted below.

Files on the Distribution CD–ROM

The CD-ROM distributed for the Workplace Update program contains the installation
program for the Work-UP extension in the root directory of the disc.  There is also a
subdirectory or folder on the disc for each state contained on the CD.  For example, the
CD containing Ohio and West Virginia has both a 39 folder (FIPS code for Ohio) and a
54 folder (WV FIPS).  Under each state folder is a folder for each county in the state.
Continuing the Ohio (39) example, there are folders for 39001, 39003, 39005, and so on.

Each county folder contains up to eleven files.  The file named "geoSSCCC.txt" (where
SS is the FIPS state code and CCC is the FIPS county code) contains the employer
records for the county that were successfully geocoded by the Census Bureau, the
Geocoded Employer Data.  The file named "ungSSCCC.txt" contains the employer
records the Census Bureau could not geocode, the Ungeocoded Employer Data.

The other nine files are the TIGER/Line 98 ArcView shapefiles.  There are three street
line files (tgrSSCCClkA, with dbf, shp, and shx extensions), three railroad line files
(tgrSSCCClkB, with the extensions), and three water line files (tgrSSCCClkH, with the
extensions). Only the street line files are automatically loaded by the Work-UP extension.
To load the railroad and waterlines as themes, see the section in Chapter 2 entitled
Importing Other ArcView Shapefiles for Reference.

Note:  TIGER/Line 98 is the same version that was distributed at the beginning of the
Traffic Analysis Zone Update (TAZ-UP) program.  Therefore, none of the corrections or
updates that were made during that work is reflected in these files.  Unfortunately, the
shapefiles from the TAZ-UP program are not usable in Work-UP because they lack the
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address information needed for geocoding.  That is why we are distributing TIGER/Line
shapefiles with Work-UP.  It is important that you do NOT delete any TIGER/Line
shapefiles used in the TAZ-UP program from your computer.  You will need them
for the TAZ verification work.

Copying the County-Specific Files to Your Hard Disk

You should first make sure you have enough room on your hard disk to copy the TIGER
files and employer files.  We suggest you have free disk space equal to at least two times
the total of the files in the county directory on the CD to allow for the creation of other
files and to ensure sufficient workspace.  Check the size of the county folder on the CD.
If you do not know the FIPS codes for the counties in your area, open the file named
stcoufips.txt in the c:\workup\bin directory in a text editor or word processor.  Then
search for the name of your state.  It will be followed by a list of the county FIPS codes
and county names.  The codes are the folder names used on the CDs.

To copy the files from the CD to your hard disk, drag the county folder (e.g., 39001) and
all its contents to the directory c:\workup\data.  In this example, you would create the
directory c:\workup\data\39001 that would contain the eleven files from the distribution
CD.  The TIGER/Line ArcView shapefiles and Employer Data sets MUST be placed in
this location for the Work-UP extension to find them.  Note that if your computer is short
of disk space, the files for only one county at a time have to be present on the disk.

Source of the Employer Data Sets

The records distributed in the Workplace Update program come from three main sources.

The Census Bureau has licensed the majority of the records from infoUSA.  This
company was formerly known as American Business Information or ABI.  The sources of
these records are the yellow pages phone directories, the business white pages, and the
government blue pages.  (We think you may still need to augment the file with records
for large government office buildings including local, state, and federal offices.)  The
employer records were current as of October 1998.  Of the approximately 11 million
records in the national file from infoUSA, about 60 percent are for employers with fewer
than 5 employees.  We have included all these records in the Workplace Update program,
but you can choose to review employers of whatever size you think appropriate and have
time to review.

We have supplemented the infoUSA records with a national shopping center directory
that was purchased from the National Research Bureau (NRB).  In most cases, this file
includes records for both the shopping centers and the stores located within them.  The
shopping center addresses are oftentimes intersections, which do not geocode
successfully, and the stores usually have only the name of the center as their address.  For
this reason, you will find that some locations or points displayed in Work-UP have
many employers associated with them.  There may also be duplication of records
between the infoUSA and NRB files.
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The third source of records is a military installation list that was developed by the Census
Bureau from a variety of published materials.  These records do not usually contain street
addresses at all and have probably been coded to the centroid of a ZIP Code, county, or
place, along with a large number of other employers that could not be geocoded to a
precise location.  This also results in some points containing a large number of
employers.  (Note:  The names of military bases that are now closed have been retained
in the Work-UP files.  This is because we think people may still use the base names when
they report their place of work location in Census 2000.  Do not mark these records for
deletion.)

The Geography Division of the Census Bureau has attempted to geocode all the
Workplace Update records against TIGER/Line 98.  About 80 percent of the 12 million
records were successfully coded.  Based on the coding, these records have been
associated with a TIGER feature, on which side of the feature they are located, and given
latitude and longitude coordinates.  If you correct any of these records, the Work-UP
extension will recalculate these attributes based on the updated address or location you
provide.

Many of the records that did not geocode to a precise location in TIGER still contain
what appears to be accurate geographic information.  Most of the records from infoUSA
contain complete addresses and latitude/longitude coordinates.  For records that did not
geocode against TIGER, Work-UP uses the coordinates from infoUSA.  That is how
Work-UP is able to display precise locations for "uncoded" records.  Although we do
not know the details concerning how infoUSA determined their coordinates, they
frequently appear to be legitimate locations for the employers.

Technical Support

Technical support for the Work-UP software will be handled through the Journey-to-
Work and Migration Branch at the Census Bureau.  The telephone number is 301-457-
2454.  Ask for Clara Reschovsky, Gloria Swieczkowski, or Bonny Berkner.  If they are
unable to answer your question directly, they will contact ESRI for assistance and either
call you back with an answer or have someone from ESRI contact you.
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Chapter 2

Basics of ArcView GIS and the Work-UP
Extension
This chapter is intended for novice users and describes the basic features of ArcView GIS
3.1, the Workplace Update extension interface, and the Workplace Update View.  If you
are an experienced user of ArcView GIS, you may want to look only at the sections of the
chapter indicated by an asterisk (*).  They refer to features unique to the Workplace
Update extension.  The use of some buttons and tools is demonstrated in this chapter.
See Appendix A for a complete listing of the functions of the menus, buttons, and tools.

Workplace Update Interface

Application window

The Graphical User Interface
The Workplace Update extension consists of controls called menus, buttons, and tools
arranged in three bars at the top of the application window.  The menu bar provides
access to operations through pulldown menus.  The button bar provides quick access to

Graphical
User
Interface

Status Bar

Menu Bar

Button Bar

Tool Bar
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operations.  The tool bar contains tools that perform operations requiring input from the
mouse.  When the user clicks on a tool, the cursor changes to reflect the tool chosen.  A
tool remains active until another tool is clicked, allowing performance of an operation
several times without returning to the tool bar.

*Certain tools from the tool bar are also available on the toolbar shortcut menu.  Click
the right mouse button while the cursor is positioned over the map display to access this
menu.  When the toolbar shortcut menu appears, move the cursor to highlight the
operation you wish to perform, then click the left mouse button to activate the tool.

Toolbar Shortcut Menu

The Status Bar
When you place the cursor over a menu choice, button, or tool, the status bar displays a
one-line description of the operation it performs.  The status bar also displays a process
bar for lengthy operations.

Tool Tips
Placing the cursor over a button or tool displays a help string (called a tool tip) inside a
yellow box just below the location of the button or tool.

Workplace Update View

Map DisplayTable Of Contents

 Themes
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View
A view has two components:  a map display and table of contents.  The Workplace
Update extension displays features in themes and manages them in a view called
Workplace Update View.  You can display many themes for the same geographic area in
the same view.

Themes
A theme represents a set of real-world objects as map features along with attributes.  A
theme is a collection of similar geographic objects represented as lines, point, or
polygons.  Each theme has a name and one or more symbols used to display its features.

*By default, the Workplace Update View contains three themes:  Streets, Geocoded Data,
and Ungeocoded Data.  Each of the themes covers the entire geographic area of a specific
county.  For further information, see the section below entitled Importing Other
ArcView Shapefiles for Reference.

Table of Contents
The table of contents lists all themes, along with their legends, that can be displayed in a
view.

Map Display
A map display shows the features for each theme.

Common Theme Operations
Once you have themes in a view, you can turn them on or off, make them active for
operations, and change their display order.

Turning themes on and off
To display a theme in the map display you must turn it on by clicking on its check box in
the table of contents.  Clicking again will turn the theme off.  When a theme is turned on,
the Workplace Update extension draws it in the map display area; when a theme is turned
off, the Workplace Update extension does not draw the theme.  Turning a theme off
affects the display only; it does not delete features from the theme.  A theme does not
have to be turned on to perform operations on it.

Making a Theme Active
Many operations work only on active themes.  By making a theme active, you are telling
the Workplace Update extension on which theme you want the operation to be
performed.  When a theme is active, it appears raised in the table of contents. This means

Visible

Not Visible
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that it is available to perform operations on it.  You make a theme active by clicking on
its name in the table of contents.

Changing the Display Order
The Workplace Update extension draws themes sequentially starting with the theme at
the bottom of the table of contents and ending with the theme at the top of the table of
contents.  Because themes are drawn one on top of the other, a theme positioned lower in
the table of contents may be obscured by a theme positioned near the top.

To change the order in which a theme draws
1. Place the cursor over the theme in the table of contents.
2. Hold down the mouse button, then drag the theme to a new position (up or down) in

the table of contents.

Adjusting the Map Display

You can use zoom and pan tools to adjust the extent of the map display.

Zooming In
You can view an area of the map display in more detail with either the Zoom In button or
the Zoom In tool.  Use the Zoom In button to enlarge the map by a preset amount on the
center of the map display.  Use the Zoom In tool to enlarge the map by an amount on a
point you define or set the map extents with a rectangle you draw.

To use the Zoom In button
1. Click the Zoom In button on the button bar.

The map display redraws, enlarging the map based on the center of the map display
window.

To use the Zoom In tool
To zoom in on a point other than the center of the map display
1. Click the Zoom In tool on the tool bar or from the Toolbar Shortcut Menu.

2. In the map display, click on the point you want to center the map display on.
The map display redraws, enlarging the map based on the point you clicked.

Not Active

Active
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OR
To define your own map extent box
1. Click the Zoom In tool on the tool bar or from the Toolbar Shortcut Menu.

2. In the map display, press and hold the mouse button starting where you want to
locate one corner of the extent.

3. After dragging the box across the map display, release the mouse button when the
extent box is surrounding the area you wish to zoom in on.

The map display will redraw based on your specifications.

Zooming Out
You can widen the map with either the Zoom Out button or the Zoom Out tool.  Use the
Zoom Out button to widen the map by a preset amount on the center of the map display.
Use the Zoom Out tool to widen the map by an amount on a point you define.

To use the Zoom Out button
1. Click the Zoom Out button on the button bar.

The map display redraws, widening the map based on the center of the map display
window.

To use the Zoom Out tool
1. Click the Zoom Out tool on the tool bar or from the Toolbar Shortcut Menu.

2. In the map display, click on the point you want to center the map display on.
The map display redraws, widening the map based on the point you clicked.

Pan
If you want to keep the same map scale in the map display, you can move the map up,
down, or sideways by using the Pan tool.

To use the Pan tool
1. Click on the Pan tool on the tool bar or from the Toolbar Shortcut Menu.

2. In the map display, point to a location near the edge of the map then press and hold
the mouse button down.

3. With the mouse button pressed, drag the map toward the opposite edge of the map.
4. Release the mouse button to redraw the map display.
5. You can continue to press, hold, drag, and release the mouse button until you get to

the exact position on the map display where you want to be.
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Previous Extent
You can go back to a previous map display extent by clicking the Zoom To Previous
button on the button bar or from the Toolbar Shortcut Menu.

Display Entire County in Map Display
You can set the extent of the map display to the entire county by clicking the Zoom To
Full Extent button on the button bar.

Importing Other ArcView Shapefiles for Reference

*If you want to add other spatial data while reviewing employer locations, you can
import the data into the Workplace Update extension.  The imported data will be
displayed as themes in the Workplace Update View and can only be used for reference.

*Some useful spatial data may include TAZ shapefiles, TIGER/Line 98 Railroads, and
TIGER/Line 98 Water Features.  The TAZ shapefiles should be under your TAZ-UP
directory (C:\Tazup\Shape).  Both the Railroads and Water Features are included on the
CDs you received and are named tgrSSCCClkb for Railroads and tgrSSCCClkh for
Water Features.  (Note:  The file names and directories used in the Workplace Update
program contain specific FIPS state and county codes.  However, in the generic form as
used above, SS indicates that a FIPS state code will occupy these two positions in the
name, while CCC shows where the FIPS county code will appear.)  The Railroads and
Water Features shapefiles are located in the same directory as the Streets and Employer
Data Files (C:\Workup\Data\SSCCC), but they will not be automatically loaded as themes
in Work-UP.  See Importing Shapefiles below to add them as a theme.

TIGER/Line 98 shapefiles file names
Streets = tgrSSCCClka.*
Railroads = tgrSSCCClkb.*
Water = tgrSSCCClkh.*

Importing Shapefiles
To import an ArcView shapefile
1. Click the Add Theme button on the button bar.

2. In the Add Theme dialog that opens, navigate to the folder that contains the ArcView
shapefile you wish to import.

3. Click on the shapefile name you wish to import.
4. Click OK.
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The Workplace Update extension will load the shapefile as a theme into the Workplace
Update View and place it at the top of the table of contents.

Changing Theme Symbology
To change theme symbology
To change the symbology of a theme you add to the Workplace Update View, double-
click on the theme name in the table of contents.

*This displays the ArcView Legend Editor.  You can only change theme symbology for
themes you import into the Workplace Update View.  The Streets, Geocoded Data, and
Ungeocoded Data theme symbology are locked.

For more help on using the ArcView Legend Editor, see Using ArcView GIS, Chapter 6,
or from the Help menu → Help Topics → Legends.

Remove Themes
To remove an imported theme from the Workplace Update View
1. In the table of contents, click the name of the theme you wish to remove in order to

make it the active theme.
2. Click the Remove Non-Essential Themes button on the button bar.

3. If the theme name in the Delete Theme dialog is correct, click Yes to remove the
theme from the Workplace Update View.

*You can only delete themes you import into the Workplace Update View.  The Streets,
Geocoded Data, and Ungeocoded Data themes cannot be deleted from the view.

Showing Theme Feature Attributes

Each theme in the Workplace Update View has a table storing attributes about the
geographic features it contains. A theme's attribute table contains one record for each
feature in the theme.  For instance, each employer point is a feature, as is each street
segment.

Displaying the attributes of a particular feature on a map display:
1. In the table of contents, click on the theme name containing the feature you wish to

identify to make it the active theme.
2. Click the Identify tool on the tool bar or from the Toolbar Shortcut Menu.

3. Press the mouse button on any feature in the active theme on the map display to see
its attributes.  Attributes of all the features located at the same point are displayed.

*Note:  In the Workplace Update View, there may be a very large number of uncoded
employer records all assigned to the same point.  Oftentimes these records will not be
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visible in the map display when the default zoom is in effect, only when the display is
zoomed to the full extent.  This is because the uncoded records may have zeros in the
latitude and longitude coordinates, which puts them very far from the county being
displayed.  In fact, when in the full extent the streets and employer points of the county
being reviewed may be so small that they only appear to be a single dot on the map
display.  Similarly, if you are reviewing records and come upon one of these uncoded
records with no coordinates, when the map display zooms to its location it will appear as
though the map has gone blank.  No streets will be visible, nor will any amount of
panning bring you back to the street network of the county you are working on.  Again,
this is because the zero coordinates place the record so far away.

The Identify Results dialog has two columns:  the left side shows the theme and feature
you chose, and the right side shows the feature's attributes.

To close the Identify Results dialog, click the X on the title bar.

Labeling Theme Features in the Map Display

Sometimes labeling theme features can help you orient yourself within a map display.

Labeling Streets
Labeling all the streets in the map display
The Workplace Update extension provides you with a quick way to label streets in a
batch mode.
To label streets, you can

Select the Labels menu and choose the Label Streets option.
OR

Click the Label Streets button on the button bar.

OR
Select Label Streets from the Toolbar Shortcut Menu.

This will auto label the street theme features that fall within the map display extent with
their name.
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Labeling Individual Features
To label individual theme features
1. In the table of contents, click on the theme name containing the features you wish to

label in order to make it the active theme.
2. Click on the Label tool on the tool bar or from the Toolbar Shortcut Menu.

3. Then in the map display, click the mouse button on the feature you wish to label.
This should label only that feature you choose in the map display.

Deleting Labels
To remove all labels in a map display

Select the Labels menu and choose Remove All Labels.
    OR
Click the Remove Labels button on the button bar.

    OR
Select Remove Labels from the Toolbar Shortcut Menu.

To remove a single label from the map display
1. Select the label by clicking the Pointer tool in the tool bar.

2. Click the mouse button on the label you wish to remove in the map display.  Black
boxes called handles will appear around the label you selected.

3. You can either select the Labels menu and choose Delete Graphics or hit the Delete
key on your keyboard.

The label should disappear from the map display.

Moving Labels
To move a label to a new position
1. Click on the Pointer tool on the tool bar.

2. In the map display, click the mouse button on the label you wish to move.  Black
boxes called handles will appear around the label you selected.

3. Position the cursor inside the box formed by the handles; the cursor should change
into a four-headed arrow.

4. Once you have the four-headed arrow, press and hold the mouse button down to drag
the label to a new position.

5. Release the mouse button to place the label at that position.

Resize a Label
To enlarge or shrink a label
1. Click the Pointer tool on the tool bar.
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2. In the map display, click the mouse button on the label you wish to resize.  Black
boxes called handles will appear around the label you selected.

3. Position the cursor over one of the handles; the cursor should change into a two-
headed arrow.

4. Once you have the two-headed arrow, press and hold the mouse button down to drag
the handle outward or inward depending on whether you want to enlarge or shrink the
label.

5. Release the mouse button to stop resizing the label.

Printing the Workplace Update View

You can print the Workplace Update View to get a hard copy of what you see on the map
display. Select the File menu and choose Print.



20

Chapter 3

Starting the Workplace Update Extension

You can start the Workplace Update extension two different ways.

Option 1:  If you are starting a review for the first time, or do not have a saved ArcView
project (apr) from a previous review, you will need to start ArcView GIS and load the
Workplace Update extension into your ArcView session, as described below.

Option 2:  If you are continuing a review that was saved, you can start ArcView GIS and
open the saved ArcView project (apr); the Workplace Update extension will be loaded
automatically.

Option 1:  Loading the Workplace Update Extension

1. Start a new ArcView GIS session by either going to the Windows Start Menu →
Programs → Esri → ArcView GIS Version 3.1 → ArcView GIS Version 3.1 OR
double-click the ArcView icon on the desktop.

2. Select the File menu and choose Extensions.

     

This will open the Extensions dialog.

3. In the Extensions dialog, scroll down and check Workplace Update System 1.0 and
click on the OK button.



21

    

This will load the extension into the ArcView session.  You can now skip down to the
section entitled Entering the Workplace Update Extension.

Option 2:  Opening a Saved Workplace Update Review

1. Start a new ArcView GIS session by either going to the Windows Start Menu →
Programs →→ Esri → ArcView GIS Version 3.1 →→ ArcView GIS Version 3.1 OR
double-click the ArcView icon on the desktop.

2. Select the File menu and choose Open Project…

    

3. In the Open Project browser, move to either the default directory c:\workup\bin or
the directory where you saved the project file and double-click the project name (it
will have a apr extension).  By default, the Workplace Update extension saves
projects in the c:\workup\bin directory.
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This will open the ArcView project (apr) with all themes, views, record selections,
exactly as they were when the project was saved.

Entering the Workplace Update Extension

The extension will prompt you with the question "Do you want to logon as an ArcView
power user?"

• If you are well versed in ArcView GIS, choose Yes to allow all the ArcView GIS
functionality to be available behind the Workplace Update GUI.  You will be asked
for an ArcView power user password, which can be obtained from Clara Reschovsky
of the Journey-to-Work staff at the Census Bureau 301-457-2451.  If you incorrectly
type the password twice, the extension will automatically default to the non-power
user mode.

• Otherwise choose No; you will still have the full Workplace Update functionality
available to you for your review of the employer files.
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Selecting a County for Review

If you started the Workplace Update extension using Option 1

• If only one county data set is contained under C:\Workup\Data, the extension will
automatically load that county and not display the Select A County dialog (skip to
Data Input Options).

• If you do not have any county data under C:\Workup\Data, the Workplace Update
extension will not be able to get a county listing, and the extension will unload itself.

• If you have more than one county folder under C:\Workup\Data, the extension will
prompt you to select a county for review.

The choices in the Select A County dialog will be displayed based on the county data
sets contained in the C:\Workup\Data directory.

      

Data Input Options

After choosing a county to review, a Data Input Options dialog will appear.



24

You can choose to input data at this time or wait until later during the same ArcView
session to import data.

• By default, the Add data now radio button is selected and the Add street data*,
Import ungeocoded data**, and Import geocoded data** check boxes are checked.
If you click OK, all the data sets will be loaded into the Workplace Update View
(skip to Chapter 4 after reading notes on street and Employer Data).

Anytime you select the radio button Add data now, you will need to choose which
data sets to load.  If you choose the check box to Add street data*, you can also
choose to import either Employer Data set, Import ungeocoded data** and/or
Import geocoded data**.  However, if you do not choose to Add street data,
neither Import ungeocoded data nor Import geocoded data check boxes can be
selected.

• If you select the radio button to Add data later, you will need to use the Workplace
Update GUI to import data (see Adding Street Data and Importing Employer Data
Sets).

*Notes on Street Data
TIGER/Line 98 is the street data that the Workplace Update extension uses for address
matching the Employer Data sets.  The street data will be loaded into the Workplace
Update View in a theme called Streets.

If you choose to Add street data, and the street data are not set up for geocoding
(address matching), the extension will build the files necessary for geocoding when you
click OK in the Data Input Options dialog.  Depending on the size and density of streets
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in the county to be reviewed, this process could take a few minutes.  A banner will be
displayed stating "Please wait while the system creates geocode indices."

**Notes on Employer Data sets
Employer Data sets begin as ASCII files processed by the Census Bureau. These ASCII
files are the result of a geocoding process performed by the Census Geography Division.
Two ASCII files, one for employer records that geocoded and one for those that did not
geocode, are provided.  The ASCII files containing the employer records are in the
directory C:\Workup\Data\SSCCC.  The file name for the geocoded data contains a
prefix of geo followed by the state and county FIPS and an extension of txt.  The file
name for the ungeocoded data consists of a prefix of ung followed by the state and county
FIPS and a txt extension.

Example:  geo06071.txt = Geocoded Data Set for San Bernardino, CA
     ung06071.txt = Ungeocoded Data Set for San Bernardino, CA

Employer Data sets are represented as themes in the Workplace Update View and are
called Geocoded Data and Ungeocoded Data.  When the extension imports this data, it
converts the Employer Data sets into ArcView shapefiles placing them in the directory
(folder) C:\Workup\Shapes.  These shapefiles are being displayed as themes in the
Workplace Update View.

WARNING:  If the data you are importing has been imported before, in other words
shapefiles already exist for it under C:\Workup\Shapes, you will be asked whether to use
the existing shapefiles. Your answer to this question should be yes.  You should only
import each county's geocoded and ungeocoded files once.  If you do not use the
existing shapefile and the Employer Data file(s) are re-imported, YOU WILL LOSE
ALL YOUR PREVIOUS WORK ON THAT EMPLOYER DATA SET!

Adding Street Data (if not already loaded in Workplace Update View)

Once you are in the Workplace Update View, you can add street data to the view.
TIGER/Line 98 is the street data that the Workplace Update extension uses for address
matching employer locations.  The street data will be loaded into the Workplace Update
View in a theme called Streets.
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If the street data is not already loaded, you can load it by either
• Selecting the Workplace Update menu and choosing Add Street Data.
OR
• Clicking on the Add Street Data button on the button bar.

      

If you choose to Add Street Data, and street data is not set up for geocoding (address
matching), the extension will build the necessary files to allow for geocoding.
Depending on the size and density of streets in the county to be reviewed, this process
could take a few minutes.  A banner will be displayed stating, "Please wait while the
system creates geocode indices".

Importing Employer Data Sets (if not already loaded in the Workplace
Update View)

Employer Data sets are represented as themes in the Workplace Update View and are
called Geocoded Data and Ungeocoded Data.

If either one (or both) of the Employer Data sets are not already imported in the project,
you can import them by either
• Selecting the Workplace Update menu and choosing Import Employer Data.
OR

• Clicking the Import Employer Data button on the button bar.

Depending on what Employer Data themes already exist in the Workplace Update View,
you may be prompted about which Employer Data set to import.

• If none of the Employer Data sets are imported in the project, a dialog titled Import
Employer Data will be displayed in which you can select which data sets to import.
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• If only one of the Employer Data sets is imported in the project, a message box will
appear indicating that one of the data sets is already imported in the project and ask
whether you wish to import the other Employer Data set.

     

When an Employer Data set is imported, the extension looks for the ASCII file
containing the employer records in C:\Workup\Data\SSCCC\.  The file name for the
geocoded data contains a prefix of geo followed by the state and county FIPS and an
extension of txt.  The file name for the ungeocoded data consists of a prefix of ung
followed by the state and county FIPS and a txt extension.

Example:  geo06071.txt = Geocoded Data Set for San Bernardino, CA
     ung06071.txt = Ungeocoded Data Set for San Bernardino, CA

Employer Data sets are loaded into the Workplace Update View as themes.  When the
extension imports this data, it converts the Employer Data sets into ArcView shapefiles
placing them in the directory (folder) C:\Workup\Shapes.  These shapefiles are being
displayed as themes in the Workplace Update View.

WARNING:  If the data you are importing has been imported before, in other words
shapefiles already exist for it under C:\Workup\Shapes, you will be asked whether to use
these shapefiles.  Your answer to this question should be yes.  You should only import
each county's geocoded and ungeocoded files once.  If you do not use the existing
shapefile and the Employer Data file(s) are re-imported, YOU WILL LOSE ALL
YOUR PREVIOUS WORK ON THAT EMPLOYER DATA SET!
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Chapter 4

Selecting Records to Review

Because the number of employer records for your area may be quite large, the Work-UP
extension has been designed to provide several ways for you to prioritize your review and
edit of the records.  For example, you may want to review large employers first and then
in stages review smaller employers.  You might consider working on the uncoded records
before reviewing the coded file, and perhaps use different size criteria in working on the
two files.  You could also choose to work on employers in one industry, say
manufacturing, and then move on to other types of businesses, for example wholesale
trade.  You may also choose to work on the employers in one neighborhood at a time or
use the query builder to select records that meet some other criteria.  By selecting only
certain employers to review, you can prioritize your work to ensure that the most
important employers are resolved and reviewed.  The functional process figure below
shows the general flow of reviewing Employer Data.

Functional Process for Reviewing Employer Data

Chapter 3 explained how to enter the Work-UP extension by starting ArcView GIS,
loading the extension, choosing a county to review, and adding the street data and
Employer Data.  After completing these steps, you will be presented with a display
similar to the one shown below.

Choose County to Review

Validate Matched
Addresses
(Geocoded Data)

Geocode Unmatched
Addresses
(Ungeocoded Data)

Add Missing
Employers

Export Changed Employer
Data to ASCII
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Workplace Update Extension Interface

Note that in the table of contents, three themes have been automatically loaded and
displayed:  Geocoded Data, UnGeocoded Data, and Streets.  As mentioned in Chapter 1,
the railroad and water themes have not been loaded.  Chapter 2 explains how to add
themes if you would like to see the railroad and waterlines or other lines (e.g., TAZ
boundaries).

You can see that the geocoded employers are represented by blue dots in the map display.
Uncoded employer records are represented by red dots and blue dots.  The way this
works is that they start out red (uncoded) and as you resolve or geocode them, the dots
are turned to blue.  Your first look at the map display will probably show mostly red dots.
In fact, you may not be able to see any blue dots at all, only what appear to be blue lines.
This is because the blue dots have been made much smaller in this view than the red dots.
The reason for this is that there are so many more blue dots (nationally, 80 percent of the
records geocoded) that they would completely dominate the display if they were left a
bigger size.

Menus

Buttons

Tools
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Selecting Employer Data Set Records to Review

Before you begin your review, you should think about how you want to organize your
work.  Some of the possibilities are by size, geographic location, or industry type.   To
assist you in this, the Workplace Update extension contains a Select Employer Data
operation.  This operation (accessed either through the Workplace Update menu or the
Select Employer Data button) allows the user to select (flag) the employers to be
reviewed by business type (SIC code), number of employees, ZIP Code, and/or street
name.  Alternately, you can select employers for review geographically by enclosing
them in a polygon using the Select Feature tool, or you can use the Query Builder
button to construct logical expressions based on any of the employer attributes contained
in the data sets.  These latter two methods are called pre-select operations, since records
selected using them may be further refined using the Select Employer Data operation.
For example, you could highlight (select) the employers in one section of the county
using the Select Feature tool and then use the Select Employer Data button to choose
only employers with more than 50 employees to be reviewed.  The functional process
figure below shows how you can use the Select Employer Data operation.

Functional Process for Selecting Employer Data

Use Pre-Select operation to
define record base for criteria
search instead of using all
employer records (optional).

Choose Employer
Data Set theme to
flag records for
review.

Define Select Criteria by
using business type,
number of employees,
ZIP Code, and/or street
name.

Select all records that
meet criteria even if they
have already been
reviewed.

Select records that meet
criteria and have NOT been
reviewed yet.

Records that have been
flagged will be used in
review operation.
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• If you wish to apply the Select Employer Data operation to the entire county of
Employer Data, no pre-select operations should be applied (skip to Define Select
Criteria).

• If you do not wish to have the Select Employer Data operation work on all of the
employers in one county, you can pre-select records.  You can either use Spatial
Select or Query Builder to pre-select employer records for a smaller data set to apply
a standard criteria selection.

Pre-Select Operations

Spatial Select
1. Make the Employer Data set theme you wish to perform the pre-selection on the

active theme by clicking on its name in the table of contents.
2. Make sure that the Employer Data set theme is visible (a check mark appears in

the check box next to the theme name in the table of contents).
3. Click the Select Feature tool.

4. In the map display, click the left mouse button where you want the polygon to
start, click each vertex around the polygon's boundary, and then double-click the
final vertex.

5. A message window will appear telling you the number of employer records you
have selected within the polygon.  Click OK to close the window.  If this number
is not acceptable, you may draw another polygon with the Select Feature tool to
select a different set of points.

All the employer points that fall within that polygon will turn to a bright green color.
These selected employer points, rather than the entire county Employer Data set, will
serve as the record base for the Select Employer Data operation described in Define
Select Criteria.

Query Builder
1. Make the Employer Data set theme you wish to perform the pre-selection on the

active theme by clicking on its name in the table of contents.
2. Make sure that the Employer Data set theme is visible (a check mark appears in

the check box next to the theme name in the table of contents).
3. Click the Query button.

A Query Builder dialog box will open, allowing you to select employer records by
one or more logical expressions, each expression containing a field, an operator, and a
value.

Note:  In the Query Builder dialog box, abbreviated field names are used to describe
the attributes contained in the Employer Data sets.  Some of these abbreviated names
are difficult to interpret.  Consult Appendix B, Employer Data Set Record
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Description, for a fuller description of each field.  The abbreviated names used in the
Query Builder dialog box are shown in parentheses in the second column of the
record layout.

To build a query expression
a) Make sure that the Update Values box is checked.
b) DOUBLE-CLICK on the field name under the Fields list.
c) SINGLE-CLICK on the operator (=, <, >).
d) DOUBLE-CLICK on the value under the values list.
e) Click OK.
f) A message window will appear telling you the number of employer records

you have selected with the logical expression.  Click OK to close the window.
If this number is not acceptable, you may build another logical expression
with the Query Builder to select a different set of points.

g) Close the Query Builder dialog.

All the employer points that meet the logical expression will turn to a bright green
color.  These selected employer points, rather than the entire county Employer Data
set, will serve as the record base for the Select Employer Data operation described in
Define Select Criteria.

The example below will select all the employer points whose name is Wal-Mart.

In order to use a wild card character (*) in the query expression, you must type in the
box that contains the query expression.  For example, if you wish to select all
employers whose business name starts with the letter W, the expression should look
like this:  ([Name] = "W*").  Note that the quotation marks are required in the
expression and must be typed in by the user if the attribute is not a numeric field.
Most fields in the Employer Data sets are alpha or character fields and will require
the use of quotation marks.  This includes some fields that may look numeric but are
not, such as the SIC code (srcpsic).
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For more help on the Query Builder, choose the Help menu → Help Topics →
Query Builder or see page 189 of your ArcView GIS manual.

Define Selection Criteria

Whether you are working with the entire county Employer Data set or a pre-selected set
of employers, you can define the selection even further by using employer-specific
attributes such as business type, number of employees, ZIP Code, and/or street name.
The purpose of the Select Employer Data operation is to flag Employer Data points for
review.

To define a selection either
• Select the Workplace Update menu and choose Select Employer Data.
OR
• Click on the Select Employer Data button on the button bar.

Depending on what Employer Data themes already exist in the Workplace Update View,
you may be prompted to indicate from which Employer Data set you want to select
records.

• If only one of the Employer Data sets is loaded in the project, the Select Dialog will
appear automatically.

• If both geocoded and ungeocoded Employer Data sets are loaded in the project, a
message box will appear asking you from which Employer Data set you wish to select
records.

The title of the Select Dialog indicates from which Employer Data set records will be
selected.
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Select Dialog Default

Inputs

By Business Type—A list of predefined industries, using ranges of 2-digit SIC codes,
will appear when you click on the down arrow.  You can also type in your own SIC code
up to 4 numbers in length.

Note:  The SIC codes in the Work-UP files come from infoUSA.  They use an extended
SIC system that is comprised of six digits, not the standard four.  However, the first four
digits of their system do equate with the standard classification.  Although we are using
SIC codes in the Workplace Update program, as in previous censuses SIC codes will not
be used in Census 2000 products.

By # of Employees—A standard list of values will appear when you click on the down
arrow.  You can choose to fill in none, one, or both inputs.  When you choose both
inputs, the more than value must NOT be greater than the and less than value; the
extension will not let you select until the more than value is less than the and less than
value.

By ZIP Code—The default value in the input is None.  When you click on the down
arrow, the other choice is Get Zips.  If you click Get Zips, the extension will return a list
of all unique ZIP Code values from the TIGER Street Theme.  One ZIP Code can be
chosen to apply to the select.

By Street Name—This input allows you to type in a street name to be applied in the
select.  Only one street name is allowed, and the input cannot be blank.  If you do not
wish to use the By Street Name criteria, the input box value should read None.
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Note:  You may choose to fill more than one input field in Select Dialog, that is, you can
combine the selection criteria.  For example, you could choose to review retail trade
employers with more than 50 employees in a particular ZIP Code.

Buttons

Select All—Will select everything that meets the select criteria regardless of what value
is in the action field.  The action field is a single-character flag that provides the status of
each record.  There is a space in the lower left area of the review dialog box where the
action field is displayed.  Possible values of the action field are

A = This record was added by the user; it was not in the original file.

C = This record was changed by the user.  This flag is assigned when the user clicks
the update button in the review dialog box.

D = This record was marked for deletion by the user.

U = This record in the ungeocoded employer file could not be geocoded or map
spotted by the user, and they clicked the unresolved button.

V = This record in the geocoded employer file was accepted by the user by clicking
the Accept button.

Blank = This record has not been reviewed by the user, or no action was taken by the
user.

So, Select All will select employer records even if they have been previously reviewed
and verified, changed, or marked for deletion.

If no select criteria have been chosen (all values in the Select Dialog are set to None),
the Select All will
• Flag all the records in the Employer Data set for the entire county

OR
• Flag the pre-selected records, if a pre-selected set is present, and you answered

Yes to Apply Select to Currently Selected Points Only.

Select Unchecked – Will select everything that meets the select criteria where the action
field has a value of blank (has not been reviewed yet).  In other words, Select Unchecked
will only select employer records that have not been reviewed.

If no select criteria have been chosen (all values in the Select Dialog are set to None),
the Select Unchecked will
• Flag either all unchecked records (action field is blank) in the Employer Data set

for the entire county



36

OR
• Flag the pre-selected records that have an action field equal to blank, if a pre-

selected set is present and you answered Yes to Apply Select to Currently
Selected Points Only.

Select Clear—Will clear the select list of previously selected employers.

Close—Closes the Select Dialog window.

Results

A Yes/No box will appear when a select is attempted.

If you apply the select, the Employer Data records that meet the select criteria will be
flagged and remain flagged until another select is applied.  The map display will also
update itself and show only the records in the Employer Data set that meet the selection
criteria.

List Selected Records

After you have selected an Employer Data set using the Select Employer Data
operation, you can view the records that have been flagged.  This is NOT a review of the
selected records; the Selected Records box only shows which records have been chosen
for review.  List Selected Records does not work with or get updated by the pre-
selection operations Spatial Select or Query Builder.

To view records that are flagged for review
1. Make the Employer Data set (Geocoded Data or Ungeocoded Data) theme active.
2. Click the List Selected Records button.
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This window shows the records that have been flagged for review.  The records being
displayed in the Selected Records box are stored in the file C:\Workup\bin\xx000sel.txt.
Every time you run the List Selected Records operation, this file gets replaced.  If for
some reason you want to retain a particular list of selected records, you should go out to
Windows Explorer and rename the file before you perform another selection.

Some useful ways to use select records file
1. Print selected records using Microsoft Excel or Notepad to import the xx000sel.txt

file.

2. Print unreviewed records by using Select Employer Data → Select Unchecked →
List Selected Records then printing xx000sel.txt using Microsoft Excel or Notepad.

3. Print unresolved records by using Query Builder to see ([Action] = "U") → Select
Employer Data → Select All → List Selected Records then printing xx000sel.txt
using Microsoft Excel or Notepad.
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Chapter 5

Reviewing Employer Data Sets

Chapter 3 covered loading the Work-UP extension, choosing a county to review, and
adding street data and Employer Data sets.  Chapter 4 described various capabilities
within the software to select subsets of records to review.  This chapter explains how to
go about reviewing the Employer Data sets.

Examining the Employer Data Sets

One way to familiarize yourself with the software and to gather information useful in
developing strategies for reviewing the records is to get record counts for various subsets
of records.  For example, use the Select Employer Data button on one of the Employer
Data sets to select employers with more than 100 employees.  Then click the Select All
button.  A message window will appear telling you how many records meet this criterion
out of the total number of records in the Employer Data set you selected (Geocoded or
Ungeocoded).  Write these numbers down for your reference and planning.  Click No in
response to the question about applying the selection, since you are really only exploring
the data sets at this point.  If you happen to apply the selection by mistake, you can easily
remove it by clicking on the Select Clear button.

Repeat this operation to define other categories of employers by which you might want to
organize your work, say by various business types (SIC codes).  Remember that you can
combine the selection criteria, so it is possible to obtain record counts by industry and
size, for example.  You can also create a listing of selected records using the List
Selected Records button.  You will need to apply the selection in this case by clicking
Yes in response to the question in the message box.  Note that when you apply a
selection, the map display is updated to show only the selected points.  Make sure you
view the list before printing it, to ensure it is a reasonable size and what you really want.
Continue to use this method to acquaint yourself with one or both of the uncoded and
geocoded Employer Data sets.

Another thing you might want to do is make a visual inspection of the employer points
across the county.  When you open the extension, the default map display is zoomed to
show the complete street network (theme) for the county.  As mentioned in Chapter 4,
you will see some red dots in the display but no blue dots, only hints of blue along some
of the streets.  This is because of the relative sizes of the different colored dots.  Some of
the red dots may fall outside the county street network.  In fact, if you zoom to the full
extent, you may find red dots located quite far away from the county.  For an explanation,
see the note in the section Showing Theme Feature Attributes in Chapter 2.

The ungeocoded records may be clustered in certain areas across the county.  If so, you
may want to consider working on employers in particular areas, one area at a time, rather
than bouncing around throughout the county as you review records.  You will have to
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zoom in more to see the geocoded employers (blue dots).  You may want to pay attention
to areas where few blue dots are shown to see if they correspond to primarily residential
areas of the county.

The choice of how to organize the review work is, of course, up to you.  Do whatever
makes sense to you for your area based on the characteristics of the Employer Data sets
and the amount of time you have to devote to the project.  The overall flow of the
Workplace Update review process is displayed for your reference in the functional
process figure below.

Functional Process for Reviewing Employer Data

Review All
Employer Points

Use Select Employer Data Button or
Menu Option to Subset Records

Use Spatial Select or Query Builder to
Select Employer Points for Review

Pick Employer Data Set to Review

Geocoded Data Ungeocoded Data

Accept Update Delete Unresolved Update Delete

Non-
Address
Changes

Address
Changes

Re-Geocode

Match
Found

Match Not
Found

Use Map
Display to
Locate
Employer

Agree
with
Match
Found

Disagree
with
Match
Found

Non-
Address
Changes

Address
Changes

Geocode

Match
Found

Match Not
Found

Use Map
Display to
Locate
Employer

Agree
with
Match
Found

Disagree
with
Match
Found

Employer Record
flagged as being
reviewed
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Begin the Review of Employer Data Sets

To review an Employer Data set either

• Select the Workplace Update menu and choose Review Employer Data.
OR
• Click on the Review Employer Data button on the button bar.

If you have more than one Employer Data set theme in the Workplace Update View, the
extension will ask you to choose which Employer Data theme you wish to review.

Based on which Employer Data set you want to review, click the appropriate text within
this section

• Geocoded Data—Review Geocoded Employer Data
• Ungeocoded Data—Review Ungeocoded Employer Data

To review all employer points in a data set, do not apply any select criteria to the data set
as described in Chapter 4.  If you currently have a selection criteria applied to your data
set, you can clear it (refer to Chapter 4).  If you do not have any selection criteria applied
to your data set, the following dialog will appear when you attempt to start a review.
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If you have applied selection criteria as described in Chapter 4, the Review Dialog opens
automatically when you attempt to start a review.

Review Geocoded Employer Data

The purpose of the review of Geocoded Employer Data is for you to verify that the
Census Bureau has coded the records to the correct location.  If the location shown for an
employer is correct, you signify this by clicking the Accept button.  If it is not correct,
you enter a new or different address and click the Update button to have the record re-
geocoded.  You can also mark records of employers no longer in existence for deletion by
clicking the Delete button.

Note that none of the records distributed by the Census Bureau contain alias names.  As
you are reviewing the geocoded records, any common aliases or abbreviations you are
aware of should be added.  This will help significantly in matching responses during the
Census Bureau's place-of-work coding operation.  Since there is only one alias field per
record, you will have to use the Add Employer function to create additional employer
records if you want to assign multiple aliases.  You must close the Geocoded Review
Dialog in order to Add Employers.

Additional materials to have on hand that you may find helpful in your review include the
following.  A local street map, in particular one with a street name index, will be useful in
locating streets you are not familiar with.  A map showing ZIP Code boundaries or a ZIP
Code directory will help you determine the appropriate ZIP Code for a local area.  The
Work-UP extension attempts geocoding within a specified ZIP Code.  If the given ZIP
Code is incorrect, the address cannot be geocoded.  Of course, any local files of employer
names and addresses that are available will also be extremely useful in your review.

Using either all the records for the county or the records you have chosen using one of
the selection operations, the extension will display information for geocoded employer
records in a Review Dialog as shown below.  The extension will center the map display
on the employer point being shown in the dialog, zoom to a pre-set factor, and label the
streets in the map display.  The dot representing this active employer point will usually
change from blue to a bright green color.

Note:  The blue dots representing the coded employers do not change in size as the scale
(zoom factor) being used in the map display changes.  This is why they appear small in
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the default map display.  Conversely, when zoomed in very close the blue (or green) dots
appear very large in size.  This creates problems at scales of around 1:1,500 or below
when trying to use the Identify or Label tools.  You must click in the exact center of the
large dot in order to label or identify the point.  If you do not hit the precise center,
nothing happens.  You must either continue trying to click the center or zoom out to a
different scale.

In instances where the dot does not turn green, it is because multiple employers are
located at the same point.  A blue dot representing a different employer at that location is
covering up the green dot of the active record.  To highlight the location of the active
record, click the Flash button in the Review Dialog.  The point representing the active
employer record will enlarge and blink several times so you can see where it is located.

If you wish to identify all the employers located at that location, click the Geocoded
Data theme in the table of contents to make it active, and using the Identify tool click the
point at the active employer's location.  The Identify Results window will pop up listing
the records located at that point and the attributes of each employer.  The records in both
the Review Dialog and the Identify Results window are listed alphabetically by
employer name.

The Geocoded Employer Review Dialog, its input fields, buttons, and read-only fields, is
described below.

Geocoded Employer Data Set Review Dialog

Inputs

Name—Name of the employer
Alias—Secondary name of employer
Address—Physical street address of employer or closest intersection*
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City—City or Post Office name where employer is located
State—State in which employer is located
Zip—5 Digit ZIP Code in which employer is located
Number of Employees—Current number of employees

* Note:  If you use closest intersection in the address input, you must separate the street
names with a & (Main St & Common Ave).

Buttons

Accept—Allows you to approve or verify that the location and other information about
the employer that came from the Census Bureau are correct.

• If you have not changed any of the inputs, when you click Accept the action field
will be set to "V" for verified and you can go to the next record.

• If any changes have been made in the input fields and you choose Accept, the
extension will alert you to what has changed and warn that these changes will be
ignored if you continue the accept process.  (In order to have the changes you
made go into effect, you should click the Update button.)

If you click Yes here, indicating you want to continue with the Accept process,
any changes you have made to the record are ignored and the action field for the
employer is set to "V" for verified.  You can then move on to the next record.

If you choose No in response to this question, you will be returned to the review
dialog.

Update—Click this button after you have made changes to the employer information
being displayed in the dialog.

• If you have only made changes to non-address input fields (Name, Alias, or
Number of Employees), Update will ask if you want to re-geocode the employer
point.
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A No answer will automatically write any values that have been changed to the
Employer Data set and make the action field "C" for changed.  A Yes answer will
attempt to re-geocode the address values (see below for geocoding process).

• If you have changed any address inputs (Address and/or Zip), Update will
attempt to geocode (address match) the employer using the new information you
provided.

Geocoding Process
1. If an address match is found, a black dot is placed at the address location in

the center of the map display, and the extension will ask you if the address
location it found is correct.
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If you agree with the address location in the map display, click Yes and the
extension will update the data set for the employer and make the action field "C"
for changed.  You may now move on to the next record.

Note:  In the case of an intersection, you will be asked which quadrant of the
intersection the employer is in because the employer cannot be located in the
intersection.  If you choose No, the record will not be updated.

       

2. If either an address match is not found or you do not agree with the address
location in the map display (click No), you will be asked to locate the
employer by using the map display.

If you choose Yes to use the map to locate the address, you must click on the map
display to indicate the employer location.  The Use Map for Address tool will be
enabled and selected in the tool bar.  The cursor will change to a bull's eye
indicating that you should click on the map display to indicate where the
employer is located.  You may zoom in, zoom out, pan, and label streets as long
as you click the Use Map for Address tool when you are ready to click the
employer location on the map display.

If you choose No to use the map to locate the address, the employer record will
not be changed.  Even though the review dialog will still be displaying the new
information you typed in, the extension will not alter the Employer Data set
because the geocoding was not successful.  If you go to the next or previous
record, the information on the current employer will default back to the original
values.
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Using a search tolerance, the extension will attempt to return an interpolated
address based on the street segment closest to where you clicked in the map
display.

• If no street segment falls within the extension's search tolerance, it will ask
you to manually select the street to associate with the employer point.

Once a street segment is associated with an employer point, the interpolated
address will be displayed for you, if possible.  If this interpolated address is
different than the address typed into the Address input, the extension will ask you
which address value you wish to write to the data set.  Choose the address that is
most likely to be reported by the employees of that business.  If an address could
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not be interpolated, the point you clicked on in the map display will be accepted
as the location of the employer.

Your answer to this question does not alter the location or point associated with
the employer.  If you click Yes, the interpolated address will be written to the
Employer Data set.  A No response writes the address in the review dialog to the
Employer Data set.  The location of the employer is not changed in either case.
The action field is set to "C" for changed, and you may now move on to the next
record.

Delete—Sets the action field to "D" for delete for that particular record.  This option does
not actually delete the Employer Data set point.

Previous Record—Moves to the previous record in the select list.

Next Record—Moves to the next record in the select list.

Flash—Flashes, in the map display, the record currently being shown in the review
dialog.  Flash is useful for locating points that are in a cluster or hidden beneath other
points.

Close—Closes the review dialog box only.

Read Only Inputs

Action—Shows the current value of the action field in the data set for that employer, if a
value is present (A = Add, C = Change, D = Delete, V = Verified, blank = Unchecked).
All records have a default value of blank and will remain blank until you take an action
on the record.  Just looking at the record will not cause the action field to change.

Record __of__  –Shows the current position, in reference to the count of selected
records, for which the dialog is displaying employer information.
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Review Ungeocoded Employer Data

The purpose of the review of Ungeocoded Employer Data is for you to provide address
and/or location information for employers the Census Bureau was not able to geocode.
You enter a new or different address and click the Update button to have the record re-
geocoded.  If the address cannot be geocoded against TIGER/Line 98, but you know
where it is located, you can click on the map display to indicate the point to be associated
with the employer.  If you are unable to find a geocodable address for the employer and
do not know the location of the business, you click the Unresolved button to indicate that
the location of the record could not be determined.  You can also mark records of
employers no longer in existence for deletion by clicking the Delete button.

Note that none of the records distributed by the Census Bureau contain alias names.  As
you are reviewing the uncoded records, any common aliases you are aware of should be
added.  This will help significantly in matching responses during the Census Bureau's
place-of-work coding operation.  Since there is only one alias field per record, you will
have to use the Add Employer function to create additional employer records if you
want to assign multiple aliases.  You have to close the Ungeocoded Review Dialog in
order to Add Employers.

Additional materials to have on hand that you may find helpful in your review include the
following.  A local street map, in particular one with a street name index, will be useful in
locating streets you are not familiar with.  A map showing ZIP Code boundaries or a ZIP
Code directory will help you determine the appropriate ZIP Code for a local area.  The
Work-UP extension attempts geocoding within a specified ZIP Code.  If the given ZIP
Code is incorrect, the address cannot be geocoded.  In particular, the shopping center and
store names from the Shopping Center directory may have incorrect ZIP Codes on the
records.  The ZIP Codes have to be corrected in order for the records to be successfully
geocoded.  Of course, any local files of employer names and addresses that are available
will also be extremely useful in your review.

Even though the records in the Ungeocoded Employer Data set have not been
successfully geocoded to a precise location by the Census Bureau, they are still
represented by points on the map display.  Some of these points quite likely represent the
correct locations of the employers.  For example, most of the records from infoUSA have
complete street addresses and latitude/longitude coordinates.  When these records could
not be geocoded by the Census Bureau, the infoUSA coordinates were retained on the
records and are used to show the location of the business on the map display.  The
infoUSA coordinates often seem to place the employer point very close to what appears
to be the correct location.

Points representing other employer locations in the Ungeocoded Data set are clearly not
correct.  These may be based on coordinates representing the centroid of a city, ZIP
Code, or county.  There are also some records that have zero in one or both coordinate
values.  See the note in the Showing Theme Feature Attributes section of Chapter 2
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for a discussion of the strange occurrences in the map display resulting from these
records.
Using either all the records for the county or the records you have chosen using one of
the selection operations, the extension will display information for uncoded employer
records in a Review Dialog as shown below.  The extension will center the map display
on the employer point being shown in the dialog, zoom to a pre-set factor, and label the
streets in the map display.  To highlight the location of the active record, click the Flash
button in the Review Dialog.  The point representing the active employer record will
enlarge and blink several times so you can see where it is located.

In reviewing the uncoded records, look for deficiencies or errors in the address
information that could have prevented it from geocoding.  Common errors include an
incorrect ZIP Code, a misspelled street name, the addition of a suite number, a
nonstandard abbreviation of a street type, or lack of a necessary street directional.
However, it is also possible that the record did not code because of a deficiency in the
TIGER/Line file.  Note that you do not have to change the address information in the
Review Dialog.  If you click the Update button ArcView will attempt to re-geocode the
address even if nothing has changed.  It is possible that the record could code
successfully, since the ArcView GIS coding algorithms are different than the Census
Bureau's.

As noted in Chapter 1, there will be instances where you will find a very large number
of employers associated with the same point.  To identify all the employers located at the
same location as the active record in the Review Dialog, click the Ungeocoded Data
theme in the table of contents to make it active, and using the Identify tool click the point
at the active employer's location.  The Identify Results window will pop up, listing the
records located at that point and the attributes of each employer.  The records in both the
Review Dialog and the Identify Results window are listed alphabetically by employer
name.

The Ungeocoded Employer Review Dialog, its input fields, buttons, and read-only fields,
is described below.
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Ungeocoded Employer Data Set Review Dialog

Inputs

Name—Name of the employer
Alias—Secondary name of employer
Address—Physical street address of employer or closest intersection*
City—City or Post Office name where employer is located
State—State in which employer is located
Zip—5 Digit ZIP Code in which employer is located
Number of Employees—Current number of employees

* Note:  If you use closest intersection in the address input, you must separate the street
names with a & (Main St & Common Ave).

Buttons

Unresolved—Allows you to tag records in the data set for which no location can be
found.  The action field for the employer record is set to "U" for unresolved.  You may
now move on to the next record.

Update—Click this button after you have made changes to the employer information
being displayed in the dialog.

• If you have only made changes to non-address input fields (Name, Alias, or
Number of Employees), Update will ask if you want to re-geocode the employer
point.
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A No answer will automatically write any values that have been changed to the
Employer Data set and make the action field to "C" for changed.  A Yes answer
will attempt to re-geocode the address values (see below for geocoding process).

• If you have changed any address inputs (Address and/or Zip), Update will
attempt to geocode (address match) the employer using the new information you
provided.

Geocoding Process
1. If an address match is found, a black dot is placed at the address location in

the center of the map display, and the extension will ask you if the address
location it found is correct.
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If you agree with the address location in the map display, click Yes and the
extension will update the data set for the employer and make the action field
"C" for changed.  You may now move on to the next record.

Note:  In the case of an intersection, you will be asked which quadrant of the
intersection the employer is in because the employer cannot be located in the
intersection.  If you choose No, the record will not be updated.

              

2. If either an address match is not found or you do not agree with the address
location in the map display (click No), you will be asked to locate the
employer by using the map display.

If you choose Yes to use the map to locate the address, you must click on the map
display to indicate the employer location.  The Use Map for Address tool will be
enabled and selected in the tool bar.  The cursor will change to a bull's eye
indicating that you should click on the map display to indicate where the
employer is located.  You may zoom in, zoom out, pan, or label streets as long as
you click the Use Map for Address tool when you are ready to click the
employer location on the map display.
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Using a search tolerance, the extension will attempt to return an interpolated
address based on the street segment closest to where you clicked in the map
display.

• If no street segment falls within the extension's search tolerance, it will ask
you to manually select the street to associate with the employer point.

Once a street segment is associated with an employer point, the interpolated
address will be displayed for you, if possible.  If this interpolated address is
different than the address typed in the Address input, the extension will ask you
which address value you wish to write to the data set.  Choose the address that is
most likely to be reported by the employees of that business.  If an address could
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not be interpolated, the point you clicked on in the map display will be accepted
as the location of the employer.

Your answer to this question does not alter the location or point associated with the
employer.  If you click Yes, the interpolated address will be written to the Employer
Data set.  A No response writes the address in the review dialog to the Employer Data
set.  The location of the employer is not changed in either case. The action field is set
to "C" for changed, and you may now move on to the next record.

Delete—Sets the action field to "D" for delete for that particular record.  This option does
not actually delete the Employer Data set point.

Previous Record—Moves to the previous record in the select list.

Next Record—Moves to the next record in the select list.

Flash—Flashes, in the map display, the record currently being shown in the review
dialog.  Flash is useful for locating points that are in a cluster or hidden beneath other
points.

Close—Closes the review dialog box only.

Read Only Inputs

Action—Shows the current value of the action field in the data set for that employer, if a
value is present (C = Change, D = Delete, U = Unresolved, blank = Unchecked).  All
records have a default value of blank and will remain blank until you take an action on
the record.  Just looking at the record will not cause the action field to change.

Record __of__—Shows the current position, in reference to the count of selected
records, for which the dialog is displaying employer information.

Adding Employers

You can add employers to the Geocoded Employer Data set only if the Geocoded
Employer Data is loaded as a theme in the Workplace Update View.
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To Add employer records either
• Select the Workplace Update menu and choose Add Employer.
OR
• Click the Add Employer button on the button bar.

Add Employer Dialog

Inputs

Name—Name of the employer*
Alias—Secondary or alternative name of employer
Address—Physical street address of employer or closest intersection*#
City—City or Post Office name where employer is located*
State—State in which employer is located*
Zip—5 Digit ZIP Code in which employer is located*
Number of Employees—Current number of employees

 *Required fields in order to geocode

# Note:  If you use closest intersection in the address input, you must separate the street
names with a & (Main St & Common Ave).

Buttons

Geocode - Geocode will attempt to address match the location typed in by you.

1. If an address match is found, a black dot is placed at the address location in
the center of the map display, and the extension will ask you if the location it
found is correct.  If you agree with the address location in the map display,
click Yes.
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The extension will ask you if you wish to save the point to the Geocoded
Employer Data set file.

If you agree, the extension will add a record to the Geocoded Employer Data set
with the location and information you provided for the employer.  The action field
will be set to "A" for added.  After the record is added and saved to the Geocoded
Data set, it becomes available for query and review with the regular geocoded
data.  You may now add another employer or Close the dialog.

Note:  In the case of an intersection, you will be asked which quadrant of the
intersection the employer is in because the employer cannot be located in the
intersection.  If you choose No, the record will not be updated.
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2. If either an address match is not found or you do not agree with the address
match location the extension found, you will be asked to locate the employer
by using the map display.

If you choose Yes to use the map to locate the employer point, you must click on
the map display to indicate the employer's location.  The Use Map for Address
tool will be enabled and selected in the tool bar.  The cursor will change to a
bull's eye indicating that you should click on the map display to indicate where
the employer should be located.  You may zoom in, zoom out, pan, and label as
long as you click the Use Map for Address tool when you are ready to click the
employer location in the map display.
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Using a search tolerance, the extension will attempt to return an interpolated
address based on the street segment closest to where you clicked in the map
display.

• If no street segment falls within the extension's search tolerance, it will ask
you to manually select the street to associate with the employer point.

Once a street segment is associated with an employer point, the interpolated
address will be displayed to you.  If this interpolated address value is different
than the address typed in the Address input, the extension will ask you which
address value you wish to write to the Employer Data set.  Choose the address
that is most likely to be reported by the employees of that business.



59

The address location along with all the other employer information you entered
will then be written to the Geocoded Employer Data set.  The action field is set to
"A" for added.  You may now add another employer or Close the dialog.

If you choose No to the location correct Yes/No box or No to the Use Map to
locate box or No to the Save File to Geocoded Records Yes/No box, nothing will
be added to the Geocoded Employer Data set.

Close—Closes the Add Employer dialog box only.

Reviewing Data for Another County

If you wish to begin the review of Employer Data for another county without leaving
ArcView, you can do so by either
• Selecting the Workplace Update menu and choose Review Employer Data for

Another County.
OR
• Clicking on the Review Employer Data for Another County button on the button

bar.

The extension will ask you if you really want to move to another county.  Note:  this
procedure should only be used for your initial work session on a county.  You should
NOT use it to switch back and forth between counties.  You should save your work as a
project file and open and close projects if you want to switch from one county to another
in your review.
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If you choose Yes, the extension will ask you to select the county to switch to.

Then the extension will ask if you want to export the current Employer Data set before
switching to another county.  Only export the data for the county if you are absolutely
sure you are done reviewing it.

If you click Yes, the themes for the previous county will be unloaded from the Workplace
Update View.  Then you will be asked which Employer Data sets you want to load for the
county you switched to.
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Chapter 6

Exporting Employer Data Sets

After reviewing the Employer Data sets, you must use the Workplace Update extension
to export the results to ASCII files.  These files will be sent back to the Census Bureau.
A Web page is being set up at the Census Bureau that will allow you to upload the ASCII
files from your Web browser.

You can invoke the export process by either
• Selecting the Workplace Update menu and choose Export Reviewed Employer

Data.
OR
• Clicking on the Export Reviewed Employer Data button on the button bar.

Depending on what Employer Data themes are loaded in the Workplace Update View,
you may be prompted to choose which Employer Data to export.

• If only one of the Employer Data sets is loaded, the extension will export that data set
directly.

• If both Employer Data sets are loaded in the project, a message box will appear
asking whether you want to export one or both of the Employer Data sets.

The export files will be placed in the C:\Workup\Export directory.  The names will be
the same as the import files described in the import section of this document.
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Sending Completed Files to the Census Bureau

To send the files you have finished updating and reviewing back to the Census Bureau,
point your Web browser at www.census.gov/cgi-bin/workup/sendfile.  This will bring
you to a Web page that contains a form for you to fill out.  At the top of the page are
fields for you to enter a user name and password.  For the user name, type in the word
workup.  For the password, type in ctpp2000.  Note that these fields are case sensitive.

Continue filling out the form on the page, providing the name of your agency, your name,
your phone number, and your e-mail address.  The first three of these items are required
information and must be provided.  If you have an e-mail address and enter it, you will
receive an e-mail confirmation notice that your files were received.  If you do not have an
e-mail address and want confirmation that your files were received, call one of the people
providing Technical Support (see Chapter 1) on the next business day after submitting
the files.

Once you have filled out the necessary contact information, you will need to identify the
files you want to upload.  There are four fields available for you to enter file names in, so
you can send the geocoded and ungeocoded files for two counties at once.  Click on the
Browse button to navigate on your computer to the directory where the files are located:
c:\workup\export.  After you have reached the proper directory, you may click on or
type in the file name to upload.  If you have a large number of files to upload, call one of
the Technical Support personnel for instructions on accessing the FTP site directly.

After you have entered the file names in the appropriate areas of the page, click the
Upload button and your files will be uploaded.  If you have a problem with the upload or
do not receive notification of your submission, call one of the contact people listed in the
Technical Support section of Chapter 1.

Returning Licensed Employer Files to the Census Bureau

Because of the stipulations of the licensing agreement with infoUSA, the materials used
in the Workplace Update program cannot be retained by the MPO and state agencies that
conducted the review.  The license only allows for the use of the records in Census 2000
place-of-work coding.  It does not cover the use of the records for other purposes within
the participating agencies.  Therefore, you must return the original distribution CDs to the
Census Bureau and delete any copies of the employer records from your agency
computers.  Please send the CDs to

Clara Reschovsky
Population Division
U.S. Bureau of the Census
Washington, DC  20233-8800



63

We appreciate your willingness to participate in this program and to devote your agency
resources to helping us improve the quality of place-of-work coding in Census 2000.
Please direct your comments about the Workplace Update program, both favorable and
critical, to Phillip Salopek at the address given above, or e-mail him your comments at
psalopek@census.gov.  Thank you.
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Appendix A

Graphical User Interface (GUI)
Menus

• File menu
• Save Project:  Saves the current ArcView project.
• Save Project As:  Saves the current ArcView project to a new name.
• Print:  Prints the Workplace Update View extent.
• Print Setup:  Edits the printer and printing options.
• Exit:  Exits ArcView and the Workplace Update extension.

• Workplace Update menu

• Add Street Data:  Adds TIGER/Line 98 street data as a theme into the Workplace
Update View.

• Import Employer Data:  Adds the Employer Data as a theme into the Workplace
Update View (requires street data to be added already).

• Select Employer Data:  Allows you to select Employer Data by a variety of different
attributes in order to systematically approach the review process.

• Review Employer Data:  Starts the review process on the Employer Data.
• Add Employer:  Allows you to add a missing employer to the Geocoded Data.
• Export Reviewed Employer Data:  Exports the reviewed data set to a file that can be

sent back to the Census Bureau.
• Review Data For Another County:  Allows you to switch to another county to begin a

review of that county.

• Labels menu

• Label Streets:  Labels the streets theme, by street name, for streets that are within the
Workplace Update View extent.

• Remove All Labels:  Removes all the labels from the Workplace Update View.
• Delete Graphics:  Deletes the selected graphic from the Workplace Update View.  A

graphic is a text string that is placed in the map display using a labeling operation.

• Help menu
• Help Topics:  Displays the dialog for browsing and searching the ArcView GIS help

system.
• How to Get Help:  Provides instructions for how to obtain help from ArcView.
• About ArcView:  Provides information about ArcView GIS.

Buttons (in order from left to right)

• Save Project:  Saves current ArcView project.
• Add Theme:  Inserts theme in the Workplace Update View.
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• Remove non-essential themes:  Removes the active, non-essential theme from the
Workplace Update View.  Essential themes are Streets, Geocoded Data, and Ungeocoded
Data.

• Zoom to full extent:  Zooms to the extents of all themes in the Workplace Update View.
• Zoom to Active Theme(s):  Zooms to the extents of the active themes.
• Zoom to Selected:  Zooms to the extents of selected features.
• Zoom in:  Zooms in on the center of the map display.
• Zoom out:  Zooms out on the center of the map display.
• Zoom to Previous Extent:  Goes back to the previous extent you were viewing.
• Query Builder:  Displays the query builder to select features with a logical expression.
• Add Street Data:  Adds TIGER/Line 98 street data as a theme into the Workplace Update

View.
• Import Employer Data:  Adds the Employer Data as a theme into the Workplace Update

View.
• Select Employer Data:  Allows you to select Employer Data by a variety of different

attributes in order to systematically approach the review process.
• List Selected Records:  Allows you to view a list of records that were selected using the

Select Employer Data operation.
• Review Employer Data:  Starts the review process on the Employer Data.
• Add Employer:  Allows you to add a missing employer to the Geocoded Data.
• Export Reviewed Employer Data:  Exports the reviewed data set to a file that can be sent

back to the Census Bureau.
• Review Employer Data For Another County:  Allows you to switch to another county to

begin a review of that county.
• Label Streets:  Labels the streets theme, by street name, for streets that are within the

Workplace Update View extent.
• Remove Labels:  Removes all the labels from the Workplace Update View.

Tools (in order from left to right)

• Identify:  Provides information about a feature in the active theme.
• Pointer:  Selects, moves, and resizes graphics (labels).
• Select Feature:  Selects features in the active theme.
• Zoom In:  Zooms in at a point you click or zooms in on a rectangle you drag.
• Zoom Out:  Zooms out from a point you click or zooms out to include a rectangle you drag.
• Pan:  Drags the display in the direction you move the cursor.
• Label:  Labels a feature in the active theme.
• Use Map for Address:  Allows you to choose a point on the map display to locate an

employer.

Tool Shortcut menu

• Pan:  Drags the display in the direction you move the cursor.
• Zoom In:  Zooms in at a point you click or zooms in on a rectangle you drag.
• Zoom Out:  Zooms out from a point you click or zooms out to include a rectangle

you drag.
• Previous Zoom:  Goes back to the previous extent you were viewing.
• Identify:  Provides information about a feature in the active theme.
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• Label:  Labels a feature in the active theme.
• Label Streets:  Labels the streets theme, by street name, for streets that are within the

Workplace Update View extent.
• Remove Labels:  Removes all the labels from the Workplace Update View.
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Appendix B

Employer Data Set Record Description

Field 
Seq. Oracle DB Field Name

Field 
Size Field Location Field Description

Foot-
note

MPO 
Must 
Fill *  

Workplace File Record Length = 287 Primary Employer Name File
1 Serial number (Serialnum) 10 1 10 Unique identifier for each record in the WF.

2 Unstand employer name (Name) 40 11 50 Unstandardized employer, shopping center, or military base name. *
3 Secondary Address (Secaddr) 50 51 100 Street intersection, location description, etc.  Not standardized. 

4 Unstand street address (Address) 50 101 150 Unstandardized employer street address from the source file *
5 Post office name (City) 20 151 170 Post office name from source file *
6 State Abbreviation (State) 2 171 172 State abbreviation from the source file *
7 Five digit Zip Code (Zip) 5 173 177 Five digit ZIP Code from the source file *
8 Src Flag-phone book (Src_fphone) 1 178 178 Source flag-telephone directory file of commercial listings, InfoUSA file (old name American 

Business Information File)--y/n

9 Src Flag-shopping centers (Srcfshop) 1 179 179 Source flag-Shopping Center Directory File--y/n
10 Src Flag-military (Srcfmil) 1 180 180 Source flag-Military Installation File--y/n
11 Src Phone (Srcphone) 10 181 190 Company phone number from source file (PHONE from InfoUSA)

12 Src Primary SIC (Srcpsic) 6 191 196 Standard Industrial Classifiction (SIC) code for the business's primary activity from source 
file (PRMSIC from InfoUSA)

13 Src Employee size code (Srcemcode) 1 197 197 Represents a size range for the number of employees from source file (EMPSIZ from 
InfoUSA): A=1-4; B=5-9; C=10-19; D=20-49; E=50-99; F=100-249; G=250-499; H=500-
999; I=1,000-4,999; J=5,000-9,999; K=10,000+

14 Src Num of employees (Numofemps) 7 198 204 Number of employees working at this location from source file (LOCEMP from InfoUSA).  
For military records, this field is filled with 8s.  For shopping center records, this field is filled 
with 9s. 1

15 Src GLA (Srcgla) 7 205 211 Number of square feet of gross leased area (GLA) from the shopping center file.

1
16 Src Bus status flag (Srcbusstat) 1 212 212 For phone book records, identifies the business location as a headquarters, branch, etc. 

(HDBRCH from InfoUSA):  1=headquarters, 2=branch, 3=subsidiary headquarters.  For 
shopping center records: A=center record, C=individual store record. 

17 Latitude (Lat) 10 213 222 Latitude *      3
18 Longitude (Long) 11 223 233 Longitude *      3
19 Hdr-State code (Hdrstate) 2 234 235 State code from the CRF match 2
20 Hdr-County code (Hdrcnty) 3 236 238 County code from the CRF match 2
21 Hdr-MCD code (Hdrmcd) 3 239 241 MCD code from the CRF match 2
22 Hdr-Place code (Hdrplace) 4 242 245 Census place code from the CRF match 2
23 Cur-State code (Curstate) 2 246 247 Current Tab state code (ST from GTUBCU) 2
24 Cur-County code (Curcnty) 3 248 250 Current Tab county code (CO from GTUBCU) 2
25 Cur-MCD code (Curmcd) 3 251 253 Current Tab MCD code (from GTUBCU) 2
26 Cur-Place code (Curplace) 4 254 257 Current Tab census place code (from GTUBCU) 2
27 Cur-Tract code (Curtractc) 4 258 261 Current Tab tract base (TRACTBAS from GTUBCU) 2
28 Cur-Tract suffix (Curtracts) 2 262 263 Current Tab tract suffix (TRACTSUF from GTUBCU) 2
29 Cur-Block (Curblk) 3 264 266 Current Tab block base number(BLOCKBAS from BKARA) 2
30 Cur-Block suffix1 (Curblksuf1) 1 267 267 Current Tab block suffix1 field (Tab90SUF from BKARA) 2
31 Cur-Block suffix2 (Curblksuf2) 1 268 268 Current Tab block suffix2 field (CURRSUF from BKARA) 2
32 TIGER partition (Tgrprtn) 6 269 274 TIGER partition number associated with the TIGER Line ID *      3
33 TIGER line ID (Tgrlnid) 10 275 284 TIGER line number *      3
34 TIGER line side (Tgrlnside) 1 285 285 TIGER line side indicator associated the TIGER line ID *      3
35 TIGER line source (Tgrlnsrc) 1 286 286 TIGER line source flag.  G=from automated geocoding; M=from MPO; Others to be defined

*      3
36 MPO Action Flag (Action) 1 287 287 Audit flag reflecting the action resulting from the MPO review process.  A=added; 

C=changed; D=delete; V=verified; U=reviewed/unresolved, no action taken; blank=not 
reviewed.  This field is blank in the output to the MPO.

4

MPO File Footnotes:
* All changed or added records returned to GEO from the MPOs must have data in these fields.  Blank is acceptable in all other fields on the

input record.  If a field is blank, GEO will blank that field in the WF.  The update process will perform a field by field replacement of data on
changed records.

1 When source is Shopping Center file (SRC-Flag-shopping centers=Y), the “Src Num of Employees or GLA” is written to field #15 on the
MPO output record.  Otherwise the “Src Num of employees or GLA” is written to field #14 on the MPO output.

2 Current Tab geography is written to the MPO output record for “block coded” WF records.  Current header geography is written to the MPO
output record for “ungeocoded” WF records.

3 Both lat/long coordinates and the TIGER Line numbers are required.


